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Figure 1-1
Score View

Recording Session is a powerful sequencer offering standard
MIDI sequencing features, as well as an editable musical
notation display.

The program contains three windows, or views that you use to
play and edit your musical compositions.

1
   Overview of Recording Session

This window (Figure 1-1) displays your music in standard
musical notation.  As you record, notes will appear onscreen.
When you play back the song, you can see the notes highlighted
as they are sounding.  You can also add, delete and edit notes
and phrases from this windows.

Score View
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Mixer View

This windows (Figure 1-2) is where you play, name, and adjust
tracks.  You have real-time control of the playback
characteristics of each track, so you can experiment before
making permanent changes.

This window also contains the transport button (Figre 1-3)
similar to an audio tape deck, as well as a tempo slider, a
Master Volume control, and a song location display (Counter).

Figure 1-2
Mixer View

Figure 1-4
MIDI List View

Figure 1-3
Tape Deck buttons

This window (Figre 1-4) displays your music as MIDI events.
If you are more comfortable with a traditional MIDI sequencer,
this affords you the fliexibility of minute adjustments to the
shape of each note.  In addition, you can enter and edit MIDI
messages such as Program Change, Aftertouch, Pitch Bend
and others.

MIDI List View
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Toolbox

In addition, there is a Toolbox (Figure 1-5) in the Score View
window, containing a Selection took, a Note Add tool, a Note
Delete tool, a Cut tool, and a Paste tool.

Figure 1-5
Toolbox

There is an online help facility available at all times. Simply
press F1 and you will open the Windows Help program.  The
information available online is more complete than this
manual.

If you need information about using the Help feature, choose
the Using Help item in the Help menu.  This is brief
introduction to using Help with any Windows program.

When you start Recording Session, the windows (or views)
that appear are:

Score View: at the top of the screen, beneath the
menu bar.  A Toolbox appears on the left side.

Mixer View: beneath the Score View.

You can move these windows to different locations, close them,
and size them.

Default Views

Online Help
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You can navigate through the Recording Session Help by
clicking on the topics that need explanation or clarification.
The information is organized in two ways--by procedure, and
by command reference.  There is also a glossary in case you
want to look up a particular term.

Note: You must be running a version of the Windows
Help program that ships with Windows 3.1 or
Multimedia Windows.  Earlier versions will not work
with the online help file.
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Recording Session works with any interface supported by
Windows 3.1/Multimedia Windows.  You need to set up the
interface with the proper driver in the Windows Control Panel
program before it will work with Recording Session.

You need to determine something called an Interrupt Request
level (IRQ) for the interface card.  The IBM and compatible
computers use interrupts to signal the CPU (Central Procesing
Unit, or brain) of your computer that a specific part of the
system (the MIDI interface in this case) needs attention. Many
items in a PC use interrupts -- hard and floppy disk drives,
modems, serial ports, scanners, mice, and other pointing
devices, network adapters, etc.

You must have your interface's IRQ set to a unique number, or
there will be conflicts.  If you do have a conflict, your MIDI
interface will probably not work, or work intermittently.

Some hints on interrupts --

Do not use IRQ 4 if you have an active serial port.

Do not use IRQ 3 (and 4) if you have two serial ports.

Do not use IRQ 7 if you use a print spooler.  Otherwise,
this is usually a good choice for an available interrupt.

If you have a mouse, it is probably set to IRQ 2 or IRQ 3.

Interrupts

Interface type

Before jumping into Recording Session with both feet, you
need to make sure that your MIDI interface is set up and
installed correctly.

   MIDI Setup
2

MIDI interface
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Some MIDI interfaces allow you to change their port, or I/O
address.  On occasion, another peripheral card, such as a
scanner or SCSI card, may be set to use the same port address.
In this case, you will have to change the interface or the other
peripheral to use a different port address.

Once your interface is ready, install it into an empty slot in
your computer case.  (Remember to turn off the computer
first!).  Observe static electricity precautions, as MIDI
interfaces are static sensitive devices.

Make sure that the card is seated firmly and correctly in the
slot before turning the computer on again.  If you do not feel
comfortable taking your computer apart, you may want to
ask a friend to help, or have a technician at a local computer
store install it for a small fee.

When you start Recording Session for the first time, you
will need to specify the MIDI driver you would like to use.
The MIDI Drivers dialog box (Figure 2-1) will appear.

Port address

Installing the
card

You have three choices:  Multimedia Drivers, Midisoft
Drivers, and No Drivers.

The Multimedia Drivers option uses generic drivers written
to work with any MIDI program that supports Windows 3.1/
Multimedia Windows.  You must have MIDI properly set up
in the Windows Control Panel.  Use this option if you need to
use the Windows MIDI Mapper.

Figure 2-1
MIDI Drivers dialog

box
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The Midisoft Drivers option uses a driver created specifically
for Recording Session.  If you use this, you will need to disable
any standard MIDI driver settings in the Windows Control
Panel.

The No Drivers option allows you to use the program for
display and editing, but not playback.  This is useful if you
have not yet purchased a MIDI interface.

Recording Session should now run, if you have set up your
interface correctly.  Congratulations -- this is one of the most
difficult areas for novices!

To form a complete MIDI system, you need a MIDI input device
(such as a keyboard) and a MIDI output device (such as a
synthesizer module).

For many years, the word synthesizer was connected with the
word keyboard in many people's minds.  Today, synthesizers
are recognized to be simply tone-generating devices which
can be controlled by a keyboard, as well as drum pads, motion
sensor, breath controllers, computer signal (and who knows
what else).  The synthesizer cannot distinguish between any
of these -- it's all MIDI.

Although many synthesizer (especially older models) have
keyboards attached, there is a growing trend toward separate
components, as guitarists, drummers, wind players, etc.
become interested in MIDI.  We will assume for the sake of
illustration that you have a separate keyboard controller and
synthesizer module, even if they are housed in the same case.

The Keyboard is the MIDI input device in this case (substitute
guitar controller / drum pads / pitch-to-MIDI converter etc. if
you have those instead).  Connect a MIDI cable from the MIDI
OUT jack of the keyboard to the MIDI IN jack of your MIDI

A MIDI system
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interface.  If you do nothing else, this now enables you to
record music, although you won't be able to play it back.

The synth module is the MIDI output device in this case.
Connect another MIDI cable from the MIDI OUT jack of the
interface to the MIDI IN jack of the synth module.  You now
have a complete system -- an input device (the keyboard) to
enter music into Recording Session, and an output device
(the synth module) on which to play back the finished product.

A relatively new type of synthesizer is one contained on a
sound card that installs inside a computer.  These have the
advantage of being compact and economical.  Many of these
cards are available with drivers for Windows 3.1 / Multimedia
Windows.

When you are suing a synthesizer which includes an integral
keyboard, you will be using a feature called Local Control
On.  This means there is an internal connection between the
keyboard and the synthesizer.  If there was no connection,
then you would not hear anything when you pressed a key.

A MIDI THRU connector copies any data at the MIDI IN
back out.  Many MIDI software packages provide this same
feature, usually called MIDI Thru.

A problem arises when you use a keyboard synthesizer with
Local Control On and a sequencer with MIDI Thru On.  The
keyboard sends MIDI messages to both the synthesizer and
the sequencer simultaneously.  The sequencer passes the MIDI
messages through and back to the synthesizer with a slight
delay.  The result is a doubling of notes, which is not often
useful musically.

To avoid this problem, always use Local Control On (on your
synthesizer) or MIDI Thru (on the sequencer) -- but never
both together!

Local Control
On/Off

MIDI Thru

Local Control On/Off, MIDI Thru, and
MIDI feedback
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A related problem is that many types of MIDI equipment (not
only synthesizers) have an internal MIDI Thru capability.  This
can be useful in certain situations, but when hooked into a
sequencer that also provides MIDI Thru, you end up with a
classic feedback loop.  MIDI output goes to an input, through
to an output back into an input, and around the chain, where it
starts all over again.  You will either hear garbled or stuck
notes, or everything will lock up and refuse to play.

Again, the solution is: never use MIDI Thru on both the MIDI
equipment and the sequencer simultaneously.  Recording
Session allows you to switch the MIDI Thru feature on or off
in the Options menu.

MIDI
feedback
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Spacebar

F1

F2

F3

F4

F5

F6

F7

F8

F9

Alt or F10

Shift + Del

Shift + Ins

Ctrl + Ins

Ctrl + 1

Ctrl + 2

Ctrl + 3

Play / Record toggle

Help Contents

Stop button

Rewind button

Fast Forward (FF) button

Play button

Record button

Pause button

Step Record

Step Play

Activate menu bar

(Edit) Cut

(Edit) Paste

(Edit) Copy

(View) Score

(View) Mixer

(View) MIDI List

Command Keys

   Keyboard Reference

3
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(Edit) Select All

(Options) Split Input at Middle C

(Music) Clef

(Track) Delete

(Music) Tempo

(Music) Time Signature

(Track) Insert

(Music) Key Signature

(Options) Metronome Enable

(File) New

(File) Open

(Music) Quantize

(File) Save

(Music) Transpose

(Music) Velocity

(Options) Auto Rewind

(File) Exit

File menu

Edit menu

Options menu

Setup menu

View menu

Track menu

Music menu

Help menu

Ctrl + A

Ctrl + B

Ctrl + C

Ctrl + D

Ctrl + E

Ctrl + G

Ctrl + I

Ctrl + K

Ctrl + M

Ctrl + N

Ctrl + O

Ctrl + Q

Ctrl + S

Ctrl + T

Ctrl + V

Ctrl + W

Ctrl + X

Alt + F

Alt + E

Alt + O

Alt + S

Alt + V

Alt + T

Alt + M

Alt + H
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Dialog box keys

Letter keys

Tab

Spacebar

Shift + Tab

Arrow keys

Moves to next list box, text box, check
box, command button or group of
option buttons.

Moves to previous list box, text box,
check box, command button, or group
of option buttons.

Moves and selects whithin active group
of option buttons.

Turns on or off active check box or
chooses active command button.

Moves to next item beginning with that
letter in an active list box..

Selects item with that underlined letter.

Chooses active command button.

Cancels command and closes dialog
box.

Esc

Enter

Alt + Underlined
letter



Recording Session

                                                                        4 - 15

Keys for Switching Windows

Next application

Previous application

Next windowed application

Previous windowed application

Display the Task List

Close window

Restore window

Next window

Move window

Size window

Maximize window

For applications :

Alt + Esc

Alt + Shift + Esc

Alt + Tab

Alt + Shift + Tab

Ctrl + Esc

For documents :

Ctrl + F4

Ctrl + F5

Ctrl + F6

Ctrl + F7

Ctrl + F8

Ctrl + F10
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Menu Keys

Cancels menu.

Displays Application Control menu.

Displays Document Control menu.

Displays menu.

Highlights the menu to the left or right.

Chooses command.

Choose highlighted command.

Cancels menu.

Highlights previous command.

Highlights next command.

Displays the menu to the left or right.

When menu bar is active :

Esc

Spacebar

Hyphen

Underlined letter

Left or Right Arrow

When menu displyed :

Underlined Letter

Enter

Esc

Up Arrow

Down Arrow

Left or Right Arrow
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This is a short tutorial that will help introduces a few of the
more important concepts of Reording Session.

In the following steps, you will record a short song, save it,
edit it, and re-save it with a new name.

Start the program by loading Windows and then
clicking on the Recording Session icon.

Click on the Option menu, and make sure the Lead-in
Measure option is enabled.  (It should have a check
mark next to it.  If not, drag the mouse down to the
item and release the mouse button.)

Click on the Record button in the Mixer View to begin
recording.  (You can press the F6 key on your computer
keyboard instead.)  The metronome will begin to
sound, counting off one measure before actually
recording.

Start playing a short melody as soon as the first (lead-
in) measure has passed.

When you are done, click on the Stop button in the
Mixer View.  (You can press the F2 key instead.)

If the Auto Rewind function is turned on, the song will
return to the beginning.  The Counter in the Mixer
View will display 1|1|1|.  Click on the Rewind button
if necessary to return the song to the beginning.

To play back the track you recorded, click on the Play
button in the Mixer View.  (You can press the F5 key
instead.)  Your melody will begin playing back.

Click on the Rewind button to return the song to the
beginning, if the Auto Rewind function is not turned
on.

  Tutorial

  Appendix  A

Recording
the first

track

Playing the
first track
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Click on the Record button again to record a second
track along with the first.  The metronome will sound
for one measure before recording.

You will hear your melody track playing back.  Play
a harmony line along with the melody.

When you are down, click on the Stop button to stop
recording.  Click on the Rewind button if Auto Rewind
is not turned on.

Click in the Track Name field for the first track.  The
Track Settings dialog box will open.  Within this
dialog you can not only name a track, but also assign
Program Change numbers and MIDI Channels.

Type MELODY into the Description field.  Click
OK to name the track.

Repeat these steps for the second track, using
HARMONY as the track name.

Click once in the menu bar on the File menu title.
The File menu drops down.  Choose the Save item by
clicking on it.  (Or you can use the Ctrl+S key
combination instead.)

The Save As dialog box will open up  (because you
are saving your work for the first time).

Choose the Studio File radio button if it is not already
selected.

Place the cursor into the Filename text box to the left
of the asterisk character.  The curosr changes to an I-
beam shape.

Press the Del key once to erase the asterisk.

Type in my-song1 .

Click on the OK button and the song will saved as
MY-SONG1.SNG in the \MIDOSOFT directory.

Make sure that you have the Score View open.  You
should see the two tracks you previously recorded in
notation form.  If not, choose the Score item in the
View menu, or press the Ctrl+1 key combination.

Click on the Note Add tool (shaped like a note) in

Recording
the second

track

Naming the
tracks

Saving the
song

Adding notes
with the Note

Add tool
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the Score View Toolbox.  A note palette will open up.

Click in the note palette on the picture of an eighth
note (a note with one flag on its stem).

The cursor is now a note shape, indicating that you
can place a note on a staff in the Score View.

Place the cursor on the Track 3 staff.  When you see a
line joining the note cursor and the Ruler at the top of
the Score View, you can place your note.

Click once to place a note on the staff.  Repeat this a
few times in different measures.

Click on the Solo Mode button in the Track module
for Track 3.  This will have the effect of muting all
other tracks, so that you can focus on just the track
you wish to hear.

Click on the Play button in the Mixer View.  You will
hear the notes you placed with the Note Add tool
playing back.

Click on the Solo button in Track 3 to return that track
to Play mode.

Open the MIDI List View by clicking on the MIDI
List item in the View menu, or use the Ctrl+3 key
combination.

The Track list box at the top of the window should be
set to Track 3 (not MELODY or HARMONY).  If not,
click once on the arrow to the right of the list box.
The list will crop down.  Click once on Track 3 to
choose it.

You will see the note events that you entered using
the Note Add tool.

Click on any of the displayed values to change them.
Clicking with the right mouse button will increase the
value, and using the left mouse button will decrease
the value.  (Hint: Pitch and Location will have the
most noticeable effect.)

Click once in the menu bar on the File menu title.
The File menu drop down.

Playing the
new track

Editing the
new track

Saving the
edited song
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Choose the Save As item by clicking on it.

Choose the MIDI File radio button.  (We are going to
five this sequence to a friend who has not yet
purchased Recording Session.)

Choose the Type 1 radio button.

Place the cursor into the Filename text box to the left
of the asterisk character.  The cursor changes to an I-
beam shape.

Press the Del key once to erase the asterisk.

Type in my-song2 .

Click on the OK button and the song will be saved as
MY-SONG2.MID in the \MIDISOFT directory.
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  Appendix  B

I am confused.  What is the difference between a track and a
MIDI Channel ?

Glad you asked that. A track is a sequencer concept that imitates the
many type tracks available in a recording studio.  You can record many
instruments on one track, but the most effective method is spreading
instruments out on their own tracks, for ease of editing and enhancement.
A MIDI Channels is a different concept entirely.  It is a method for
identifying MIDI data sent through a cable, so that only instruments
that are tuned to a particular Channel will receive messages assigned
to that Channel.

I just bought the new-fangled Hypemaster XJ-2001 multi-
timbral synthesizer.  I can only get it to play one part at a
time.  Why won't it play more ?

Many multi-timbral synthesizers need to be set up carefully.  You may
have only one MIDI Channel set.  Check the owner's manual for the
device, it will tell you how to switch it into multi-timbral mode and how
to set each part.

You also need to be sending out MIDI data on more than one Channel.
Check to see if the Channels you are sending out from Recording
Session and the Channels set on your multi-timbral synthesizer match
up.  An easy way to test different Channel settings is with the MIDI
Channel column in the Mixer View.

I have songs from another sequencer product. Can I load
them into Recording Session ? How do I do this ?

Recording Session can load any song from any sequencer, as long as
the song is saved in the Standard MIDI File format (Type 0 and Type
1).  The vast majority of sequencers have the capability of saving in
this format.

Troubleshooting
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My mouse was working fine before I installed my MIDI
interface and Recording Session.  Now it jumps around a lot
and acts erratic.  Do you know what is going on ?

This sounds like a classic example of an interrupt conflict.  Your mouse
and MIDI interface are probably set to the same interrupt.  This kind
of situation can be difficult to diagnose, because things don't fail,
they just act weird.  Try settings the mouse or the interface to a different
interrupt.  This should cure the problem.

The music in the Score View is sometimes displayed
erroneously for standard musical notation.  Is this a bug ?

No.  MIDI is actually more flexible (in some ways) than standard music
notation.  We made a design decision to display all MIDI, regardless
of whether it could be notated legally or not.

The music I recorded sounds fine, but the notation does not
keep up with it when I use Follow Score View Notes.  Why ?

We chose to give up priority to the proper playback of MIDI data, so
dense music and/or slow computer systems can cause the display of
notes to lag behind the music.  To be able to Follow Score View Notes,
you may have to 1) resize the Score View window so it displays fewer
Tracks,  or 2) lower the tempo setting while playing back the music.

I changed my MIDI driver in the Drivers applet in the
Control Panel, but I still can's get anything working.  What
now ?

Anytime you change driver settings in the Control Panel, it is a good
idea to reboot your machine.  First, exit Windows.  Next, take any
floppy disk out of drive A.  Next, press the Reset button (if you have
one on your computer) or flip the power switch off and on.  The new
driver settings will now take effect winthin Windows.

I saved some song files with a MID extension, but my
multimedia application cannot read them.  Why not ?

You most likely saved them as Recording Session song files.  Most
multimedia applications can only read Standard MIDI Files.  Make
sure to click on the Standard MIDI File radio button when you are
saving the file.
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  Appendix  C

Windows Control Panel

Multimedia Windows

Microsoft has released extensions to Windows, enabling it to
work with advanced sound and graphics equipment.

These extensions, which bring animation, digital audio, MIDI,
and video to the PC, are collectively called Multimedia
Windows.

MIDI setup is accomplished within the Control Panel program,
located in the Accessories group in the Windows Program
Manager.

You may have everything set up correctly.  Multimedia
Windows can detect many devices automatically.  We have
provided this section for your information, or in case of
difficulty.

Within the Control Panel are two sub-programs, or applets --
Drivers, and MIDI Mapper.

Double - click (click twice rapidly) on the Drivers icon in the
Control Panel.  You will see a list of software drivers currently
installed.  You can add or remove drivers by highlighting a
dirver and clicking the Add or Remove button, respectively.

By Selecting your MIDI device and clicking on the Setup
button, you can change the IRQ and port address settings.

You must set up your MIDI drivers correctly before using

Recording Session.

Drivers
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MIDI Mapper The MIDI Mapper applet performs a MIDI Channel, Program
Change, and Key number mapping function.  (The MIDI
Mapper driver must be installed in the Drivers applet before
the MIDI Mapper will function correctly.)

For example, if your sequence has MIDI data on Channel 13 -
16, but your synthesizer can only receive on Channels 2 - 5,
the MIDI Mapper can load a channel map that will
rechannelize 13 to 2, 14 to 3, 15 to 4, and 15 to 5.

Another example is if a sequence sends out Program Change
34, and was written to play a flute sound, your particular
synthesizer may play a tuba sound when it receives a Program
Change 34.  A Program Change map written for your particular
synthesizer would re-map the Program Change to a different
number (one that corresponded to that elusive flute sound).

Recording Session passes all data to the MIDI Mapper when
you are running in Multimedia Windows.  This means that
data may get changed or rerouted once it leaves our software.
For example, if you inserted a Program Change number 45 in
a sequence, but the MIDI Mapper switched that number to
79, all connected devices would respond to Program Changed
79, not 45.

Double-click on the MIDI Mapper icon in the Control Panel.
You can look at and edit Channel maps, Patch maps or Key
maps.  A list box displays the currently selected map.
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General MIDI

General MIDI specifies a patch-naming scheme, so that all
synthesizers that conform to the standard will play a flute sound
when they receive a Program Change 73, for example.  Many
popular synthesizers will have MIDI Mapper files designed
so that the synthesizer can be General MIDI compatible when
used with Multimedia Windows.

General MIDI Instrument Map

0-7 PIANO

0 Acoustic Grand Piano 1 Bright Acoustic Piano

2 Electric Grand Piano 3 Honky-tonk Piano

4 Rhodes Piano 5 Chorused Piano

6 Harpsichord 7 Clavinet

8-15 CHROMATIC PERCUSSION

8 Celesta 9 Glockenspiel

10 Music box 11 Vibraphone

12 Marimba 13 Xylophone

14 Tubular Bells 15 Dulcimer

16-23 OGRAN

16 Hammond Organ 17 Percussive Organ

18 Rock Organ 19 Church Organ

20 Reed Organ 21 Accordion

22 Harmonica 23 Tango Accordion
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24-31 GUITAR

24 Acoustic Guitar(nylon) 25 Acoustic Guitar (Steel)

26 Electric Guitar (jazz) 27 Electric Guitar (Clean)

28 Electric Guitar (Muted) 29 Overdriven Guitar

30 Distortion Guitar 31 Guitar Harmonics

32-39 BASS

32 Acoustic Bass 33 Electric Bass (finger)

34 Electric Bass (Pick) 35 Fretless Bass

36 Slap Bass 1 37 Slap Bass 2

38 Synth Bass 1 39 Synth Bass 2

40-47 STRINGS

40 Violin 41 Viola

42 Cello 43 Contrabass

44 Tremolo Strings 45 Pizzicato Strings

46 Orchestral Harp 47 Timpani

48-55 ENSEMBLE

48 String Ensemble 1 49 String Ensemble 2

50 SynthStrings 1 51 SynthStrings 2

52 Choir Aahs 53 Voice Oohs

54 Synth Voice 55 Orchestra Hit

56-63 BRASS

56 Trumpet 57 Trombone

58 Tuba 59 Muted Trumpet

60 French Horn 61 Brass Section

62 Synth Brass 1 63 Synth Brass 2
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64-71 REED

64 Soprano Sax 65 Alto Sax

66 Tenor Sax 67 Baritone Sax

68 Oboe 69 English Horn

70 Bassoon 71 Clarinet

72-79 PIPE

72 Picolo 73 Flute

74 Recorder 75 Pan Flute

76 Bottle Blow 77 Shakuhachi

78 Whistle 79 Ocarina

80-87 SYNTH LEAD

80 Lead 1 (Square) 81 Lead 2 (Sawtooth)

82 Lead 2 (Calliope lead) 83 Lead 4 (Chiff lead)

84 Lead 5 (charang) 85 Lead 6 (voice)

86 Lead 7 (fifths) 87 Lead 8 (bass + lead)

88-95 SYNTH PAD

88 Pad 1 (new age) 89 Pad 2 (warm)

90 Pad 3 (polysynth) 91 Pad 4 (choir)

92 Pad 5 (bowed) 96 Pad 6 (Metallic)

97 Pad 7 (halo) 98 Pad 8 (sweep)

96-103 SYNTH EFFECTS

96 FX 1 (rain) 97 FX 2 (soundtrack)

98 FX 3 (Crystal) 99 FX 4 (atmosphere)

100 FX 5 (brightness) 101 FX 6 (Goblins)

102 FX 7 (echoes) 103 FX 8 (sci - fi)
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104-111 ETHNIC

104 Sitar 105 Banjo

106 Shamisen 107 Koto

108 Kalimba 109 Bagpipe

110 Fiddle 111 Shanai

112-119 PERCUSSIVE

112 Tinkle Bell 113 Agogo

114 Steel Drums 115 Woodblock

116 Taiko Drum 117 Melodic Tom

118 Synth Drum 119 Reverse Cymbal

120-127 SOUND EFFECTS

120 Guitar Fret Noise 121 Breath Noise

122 Seashore 123 Bird Tweet

124 Telephone Ring 125 Helicopter

126 Applause 127 Gunshot
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General MIDI Percussion Key Map

Key Percussion sound

36 Bass Drum 1

38 Acoustic Snare

40 Electric Snare

42 Closed Hi Hat

44 Pedal Hi Hat

46 Open Hi Hat

48 Hi-Mid Tom

50 High Tom

52 Chinese Cymbal

54 Tambourine

56 Cowbell

58 Vibraslap

60 Hi Bongo

62 Mute Hi Caonga

64 Low Conga

66 Low Timbale

68 Low Agogo

70 Maracas

72 Long Whistle

74 Long Guiro

76 Hi Wood Block

78 Mute Cuica

80 Mute Triangle

Key Percussion sound

35 Acoustic Bass Drum

37 Side Stick

39 Hand Clap

41 Low Floor Tom

43 High Floor Tom

45 Low Tom

47 Low-Mid Tom

49 Crash Cymbal 1

51 Ride Cymbal 1

53 Ride Bell

55 Splash Cymbal

57 Crash Cymbal 2

59 Ride Cymbal 2

61 Lo Bongo

63 Open Hi Conga

65 High Timbale

67 High Agogo

69 Cabasa

71 Short Whistle

73 Short Guiro

75 Claves

77 Low Wood Block

79 Open Cuica

81 Open Triangle
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